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1 OBJETIVO 
A presente Especificação Técnica tem por finalidade determinar critérios para a elaboração e 

apresentação, por parte da Contratada, dos documentos técnicos de projeto e consultoria para 

certificação, incluindo o BIM (Building Information Model). 

Entende-se por documentos técnicos os desenhos técnicos, listas de desenhos, listas de materiais, 

orçamentos, especificações técnicas, memórias de cálculo, relatórios, relatórios de ensaios, 

manuais, memoriais descritivos e cronogramas. 

Entende-se por BIM o modelo eletrônico tridimensional cartesiano de uma instalação ou sistema, 

paramétrico, inteligente, orientado a objetos e completo em informações necessárias, para usuários 

diversificados, nas etapas de planejamento, construção e operação do conjunto de instalações e 

sistemas que farão parte do projeto. O modelo deverá agregar ainda informações de custo 

organizadas de forma que seja possível fazer seu uso no controle da execução da obra. 

2 SIGLAS E ABREVIATURAS 

 ABNT  Associação Brasileira de Normas Técnicas 

NBR  Norma Brasileira 

 BIM  Building Information Modeling ou Building Information Model 

 CAD  Computer Aided Design 

 CIS/2  CIMSteel Integration Standards 

 SDNF  Steel Detailing Neutral Format 

 IFC  Industry Foundation Classes 

 ISO  International Organization for Standardization 

 

3 DEFINIÇÕES E CONCEITOS 
Para fins desta especificação e dos serviços que ela abrange, são adotadas as definições a seguir, 

complementadas pelas definições contidas nos documentos citados no item 4 e no Termo de 

Referência n.° 82472-9999-89991-0001. 

BUILDING INFORMATION MODELING  – ou Modelagem de Informação da Construção, é o uso de 

um programa de modelagem computacional para simular toda a construção e a operação de uma 
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instalação ou sistema ou de uma composição de sistemas. O resultado é o Building Information 

Model ou Modelo de Informação da Construção. 

BUILDING INFORMATION MODEL  – ou Modelo de Informação da Construção, é a representação 

digital de uma instalação ou sistema, paramétrica, inteligente, orientada a objetos e rica em dados, 

a partir da qual vistas e dados, apropriados para as necessidades de variados usuários, podem ser 

extraídos e analisados para gerar informações que poderão ser utilizadas para a tomada de 

decisões e aperfeiçoamento do processo de construção. 

CONTRATADA  - empresa responsável pela modelagem de informação da construção, elaboração 

e apresentação dos documentos técnicos, incluindo o respectivo modelo de informação da 

construção, à COPEL. 

DESENHO TÉCNICO - representação gráfica do objeto a ser executado, em meio virtual e físico, 

elaborada de modo a permitir sua visualização em escala adequada, demonstrando formas, 

dimensões, funcionamento e especificações, perfeitamente definida em plantas, cortes, elevações, 

esquemas e detalhes, obedecendo às normas técnicas pertinentes e às especificações técnicas da 

Contratante. 

DISCIPLINAS DE PROJETO  - especialidades de projeto, tais como: arquitetura, estruturas, 

drenagem, terraplenagem, pavimentação, instalações, etc, conforme constam no Quadro 3. 

INDUSTRY FOUNDATION CLASSES  – é a definição de um formato padrão para o Building 

Information Model. O IFC deve armazenar, pelo menos, dados geométricos, cálculos, unidades, 

quantidades, preços, características técnicas, informações sobre os serviços, gerenciamento e 

relacionamento entre as áreas. As extensões IFC são públicas e abertas para implementação e  

uso de qualquer parte, são definidos pela indústria, são extensíveis e são desenvolvidas a qualquer 

tempo. 

PROJECTWISE - é um software para conectar pessoas e informações entre as equipes 

distribuídas e é usado para gerenciar, encontrar e compartilhar conteúdo de CAD, dados do projeto 

e documentos de texto, planilhas etc., bem como, colaborar para a obtenção de informações, 

concepção e elaboração de projetos, enquanto o trabalho está em andamento. 



 
 

SUPERINTENDÊNCIA DE OPERAÇÔES DE GERAÇÃO E 
TRANSMISSÃO - SOS 

Revisão:  
02 

ESPECIFICAÇÃO TÉCNICA Data: 
20/11/2013 

82472-89993-9999-0001 Total de Folhas: 
5/30 

 

ELABORAÇÃO E APRESENTAÇÃO DE DOCUMENTOS TÉCNICOS E MODELOS ELETRÔNICOS DE PROJETOS - POLO BOSQUE 
COPEL 

 

PROJETO - atividade necessária à materialização dos meios, através de princípios técnicos e 

científicos, visando à consecução de um objetivo ou meta, adequando-se aos recursos disponíveis 

e às alternativas que conduzem à viabilidade da decisão. 

4 REFERÊNCIAS 
Os documentos técnicos, incluindo modelos eletrônicos, deverão se basear nas últimas revisões 

das seguintes normas e documentos nelas citados: 

ABNT NBR 6492:  Representação de projetos de arquitetura. 

______. NBR 7191:  Execução de desenhos para obras de concreto simples ou armado. 

______. NBR 8196:  Desenho técnico – Emprego de escalas. 

______. NBR 8403:  Aplicação de linhas em desenhos – Tipos de linhas – Larguras das linhas - 

Procedimento. 

______. NBR 10068:  Folha de desenho – Leiaute e dimensões - Padronização. 

______. NBR 10126:  Cotagem em desenho técnico – Procedimento. 

______. NBR 13531:  Elaboração de projetos de edificações - Atividades técnicas. 

______. NBR 15965-1:  Sistema de classificação da informação da construção - Parte 1: 

Terminologia e estrutura. 

______. NBR 15965-2:  Sistema de classificação da informação da construção - Parte 2: 

Características dos objetos da construção. 

______. NBR ISO 10209-2:  Documentação técnica de produto – Vocabulário. Parte 2: Termos 

relativos aos métodos de projeção. 

______. NBR ISO 12006-2:  Construção de edificação - Organização de informação da construção - 

Parte 2: Estrutura para classificação de informação. 

ISO 12006-2 – Building construction - Organization of information about construction works -- Part 

2: Framework for classification of information. 
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ISO 12006-3 – Building construction - Organization of information about construction works -- Part 

3: Framework for object-oriented information. 

ISO/PAS 16739 – Industry Foundation Classes, Release 2x, Platform Specification(IFC2x Platform). 

 

5 DIRETRIZES PARA ELABORAÇÃO 

5.1 Documentos técnicos 

Todos os documentos técnicos deverão ser elaborados em computador, conforme o item 5, em 

formatos padronizados pelas normas aplicáveis da ABNT. 

Este tópico determina critérios e padrões para a elaboração dos documentos técnicos de 

engenharia. 

A CONTRATADA deverá fornecer à COPEL os desenhos descritos no Termo de Referência nº 

82472-9999-89991-0001 e nas especificações técnicas para prestação de serviços de projeto 

constantes da Lista de Documentos utilizando as representações gráficas presentes nas normas 

citadas. 

Como os desenhos das diversas disciplinas de projeto serão confrontados, todos os elementos 

deverão estar devidamente cotados e identificados para permitir a análise de interferências. 

5.1.1 Níveis ou camadas 

Deverão ser utilizados diferentes níveis (camadas ou layers) para representação de diferentes 

partes e etapas de alguma instalação ou diferentes instalações que apareçam em um mesmo 

desenho. 

5.1.2 Escalas 

Todos os modelos de informação da construção, os desenhos e os detalhes originados a partir 

deles deverão ser elaborados no Design Model, quando Microstation, Model Space, quando 

AutoCAD, ou similar, quando em outra ferramenta CAD, sempre em escala natural (1:1). O que 

deverá ser re-escalada é a visualização que aparecerá no formato de impressão (Sheet Model, 

quando Microstation, Paper Space, quando AutoCAD ou similar quando em outro ambiente CAD). 

Os detalhes poderão ter sua visualização representada em escalas diferente daquela indicada na 

folha desde que sejam informadas as respectivas escalas junto aos detalhes. 
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5.1.3 Folhas e carimbos 

As folhas deverão seguir os formatos padronizados da série A. As bordas e carimbos a serem 

utilizados serão disponibilizados no ambiente de gerenciamento eletrônico de documentos adotado 

pela Copel, denominado ProjectWise, na área de acesso da CONTRATADA. 

5.2 BIM 

O modelo BIM de cada disciplina de projeto deverá ser elaborado em 3D, seguindo-se o fluxo 

demonstrado na Figura 1 desde sua concepção. Deste modo deverão ser antecipadas a 

visualização e a solução dos conflitos de compatibilidade entre os diversos sistemas que compõem 

o modelo de cada disciplina, antes da geração dos desenhos e das folhas do projeto. 

Objetivando o desenvolvimento integrado das soluções entre as disciplinas de projeto, a 

CONTRATADA deverá vincular os modelos das diversas disciplinas entre si, conforme ilustrado na 

Figura 2, ou seja, desde o início do desenvolvimento do modelo de uma determinada disciplina, 

todas as demais disciplinas deverão ser referenciadas. Assim pretende-se evitar que interferências 

mal solucionadas entre as disciplinas sejam percebidas em um estágio avançado do projeto. 

 

Modelo 
(BIM)

“Design”

Desenhos 
de projeto
“Drawing”

Folha de projeto
“Sheet”

 

Figura 1 – Fluxo de projeto: obtenção de extrações do BIM e elaboração das folhas de projeto. 
 
Deverá ser elaborado um modelo para cada disciplina de projeto contendo todas as demais 

disciplinas referenciadas. Um modelo completo de cada obra ou edificação deverá ser elaborado 

usando apenas as referências de todos os modelos de cada disciplina de cada um dos pavimentos. 
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disciplina ...

Modelo da 

disciplina

N-2

Modelo da 

disciplina 4

Modelo da 

disciplina

N-1

 

Figura 2 – Modelo de trabalho com disciplinas refer enciadas, considerando que existam N disciplinas 

 

Os objetos que compõem o BIM deverão ser preferencialmente classificados mediante o uso das 

entidades mapeadas nativamente no programa computacional AECOsim Building Designer V8i da 

Bentley, listadas no Quadro 1. 

Quadro 1 – Lista de entidades IFC mapeadas nativame nte no programa computacional AECOsim 
Building Designer da Bentley 

IfcActuator 

IfcAirFilter 

IfcAirTerminal 

IfcAirTerminalBox 

IfcAnnotation 

IfcBeam 

IfcBoiler 

IfcBuilding 

IfcElectricDistributionPoint 

IfcElectricMotor 

IfcElementAssembly 

IfcElementComponent 

IfcEnergyConversionDevice 

IfcEquipmentElement 

IfcFan 

IfcFastener 

IfcProjectionElement 

IfcProxy 

IfcPump 

IfcRailing 

IfcRamp 

IfcRampFlight 

IfcReinforcingBar 

IfcReinforcingElement 
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IfcBuildingElementComponent 

IfcBuildingElementPart 

IfcBuildingElementProxy 

IfcBuildingStorey 

IfcBuiltIn 

IfcChamferEdgeFeature 

IfcChiller 

IfcCoil 

IfcColumn 

IfcCompressor 

IfcControlElement 

IfcController 

IfcCoolingTower 

IfcCovering 

IfcCurtainWall 

IfcDamper 

IfcDiscreteAccessory 

IfcDiscreteElement 

IfcDistributionChamberElement 

IfcDistributionControlElement 

IfcDistributionElement 

IfcDistributionFlowElement 

IfcDistributionPort 

IfcDoor 

IfcEdgeFeature 

IfcElectricalAppliance 

IfcFeatureElement 

IfcElectricalElement 

IfcFeatureElementAddition 

IfcFeatureElementSubtraction 

IfcFlowController 

IfcFlowFitting 

IfcFlowMovingDevice 

IfcFlowSegment 

IfcFlowStorageDevice 

IfcFlowTerminal 

IfcFlowTreatmentDevice 

IfcFluidMovingDevice 

IfcFooting 

IfcFurnishingElement 

IfcGrid 

IfcHeatExchanger 

IfcHeatTransferDevice 

IfcHydronicHeater 

IfcLightFixture 

IfcMechanicalFastener 

IfcMember 

IfcOpeningElement 

IfcOutlet 

IfcPile 

IfcPlate 

IfcPort 

IfcReinforcingMesh 

IfcRoof 

IfcRoundedEdgeFeature 

IfcSanitaryTerminal 

IfcSensor 

IfcSite 

IfcSlab 

IfcSpace 

IfcStair 

IfcStairFlight 

IfcStorageDevice 

IfcSystemFurnitureElement 

IfcTank 

IfcTendon 

IfcTendonAnchor 

IfcTransportElement 

IfcTreatmentDevice 

IfcTubeBundle 

IfcUnitHeater 

IfcValve 

IfcVirtualElement 

IfcWall 

IfcWallStandardCase 

IfcWindow. 

 

 

Caso não seja possível classificar um ou mais objetos com essas entidades, estes objetos deverão 

ser classificados em alguma das entidades IFC 2x3 TC1 relacionadas no site da entidade 

BuildingSmart (http://www.buildingsmart-tech.org/ifc/IFC2x3/TC1/html/index.htm). 
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O BIM deverá conter as informações necessárias para permitir a geração de especificações 

técnicas dos componentes da construção e instalações, listas de quantidades para orçamentos e 

cronogramas para planejamento da execução. 

Para isto, a CONTRATADA deverá descrever nas respectivas Property Sets do IFC 

(http://www.buildingsmart-tech.org/ifc/IFC2x3/TC1/html/pset_schema.htm) as informações 

necessárias para a descrição do objeto, tais como dimensões, modelo, fabricante, cor, 

acabamento, material, testes e ensaios, valores e unidades das grandezas que descrevem o objeto 

(potência, corrente, volume, potência dissipada, temperatura, vazão, classe de proteção IP, classe 

de isolamento, TRRF, atenuação acústica, isolamento térmico etc.), frequência de manutenção, 

normas atendidas, certificações e aprovações. 

Os objetos modelados que compõem edificações que serão submetidas à certificação de 

sustentabilidade ambiental, deverão ter no BIM a indicação de certificados, selos, classificações e 

os tipos de itens avaliados (emissão de CO2, energia consumida, resíduos gerados etc.) quando 

previstos nos referenciais de certificação, ou quando demandados pela COPEL e pela consultoria 

de sustentabilidade ambiental. 

Depois de finalizados os modelos de cada disciplina de um determinado pavimento de uma 

edificação, deverá ser criado um arquivo único contendo o modelo deste pavimento, agregando 

todas as disciplinas de projeto mediante o emprego de referências, conforme ilustrado na Figura 3. 
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Figura 3 – Processo de montagem do modelo de um pav imento P, qualquer, de uma edificação com N 
disciplinas de projeto. 

 

Conforme mencionado, inicialmente deverão ser elaborados os modelos de cada disciplina de 

projeto e na sequência os modelos de cada pavimento. O modelo completo da edificação será 

resultado da união de todos os modelos dos pavimentos em um arquivo, conforme mostra a Figura 

4. A união destes pavimentos em um arquivo deverá ser feita mediante o uso de ferramentas de 

referência, ou seja, caso ocorra qualquer alteração em qualquer dos pavimentos esta será 

representada no modelo da edificação ao atualizar a referência. 
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Modelo do 

pavimento 1

Modelo do 

pavimento 2

Modelo do 

pavimento ...

Modelo do 

pavimento 

N-1

Modelo do 

pavimento N

Modelo da 
Obra

 

Figura 4 – Processo de montagem do modelo de uma ed ificação qualquer com N pavimentos. 
 

5.2.1 Coordenadas 

Todos os modelos das diversas disciplinas deverão ter a origem, coordenada global do sistema 

cartesiano (0,0,0), coincidente. Todos os componentes de cada um dos modelos deverão ser 

modelados nas respectivas coordenadas geográficas UTM (Unidade Transversa de Mercator) em 

que serão construídos, para isso deverá ser verificado o arquivo de levantamento topográfico, 

representado neste sistema de coordenadas, com marcos georeferenciados. 

 

5.2.2 Níveis ou camadas 

Deverá ser utilizado o sistema de diferenciação por níveis ou camadas (layers) para a 

representação de diferentes grupos de itens componente do modelo. 

 

5.2.3 Objetos a serem modelados nas classes IFC 

A seguir são listados os objetos a serem modelados nas classes IFC para cada disciplina de 

projeto. Além desses, a CONTRATADA deverá modelar todos os demais objetos não listados que 

integrem o projeto contratado. 

• Arquitetura: 

Janelas, portas, paredes, pisos, forros, revestimentos, cobertura, guarda-corpos, corrimões, 

pérgolas, painéis de fechamento, painéis de revestimento, membranas e mantas isolantes, vidros, 

películas, equipamentos sanitários, esquadrias, cortinas, persianas, brizes, soleiras, peitoris, 

mobiliário e elevadores. 
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• Estruturas e fundações: 

Vigas, pilares, lajes, sapatas, blocos, blocos sobre estacas, estacas, radiers, muros de contenção, 

cortinas de contenção, vigas baldrame, escadas, rampas, tirantes, terças e treliças. 

• Instalações elétricas: 

Cabos, barramentos, eletrodutos, conduletes, eletrocalhas, conexões, lâmpadas, luminárias, 

baterias, bancos de capacitores, filtros de harmônicos, UPS, transformadores, geradores, 

dispositivos de proteção, chaves, temporizadores, medidores elétricos, sensores, leitores, motores 

elétricos, painéis e circuitos elétricos. 

• Instalações de automação predial e segurança: 

Cabos, barramentos, eletrodutos, conduletes, eletrocalhas, conexões, chaves, temporizadores, 

medidores elétricos, sensores, leitores, câmeras, controladores, alarmes, servidores, painéis, 

brackets e circuitos elétricos. 

• Instalações de climatização: 

Chillers, fan coils, vigas frias, torres de resfriamento, trocadores de calor, ventiladores, exaustores, 

compressores, dampers, filtros, grelhas, difusores, condensadores, dutos, isolamentos, suportes 

diversos, caixas VAV, unidades de tratamento de ar, conexões, silenciadores, evaporadoras, 

coolers evaporativos, válvulas, juntas de expansão, registros, tubulações, bombas, motores 

elétricos, termostatos, pressostatos, unidades evaporadoras, unidades condensadoras, câmaras 

frias, unidades splits, tanques de termo acumulação, tanques de expansão, reservatórios de água,    

e sensores. 

• Instalações hidráulicas: 

Tubulações, conexões, bombas, tanques, reservatórios, filtros, dispositivos de inspeção, caixas 

separadoras, caixas de passagem, caixas de gordura, válvulas, registros, boilers, medidores, 

sensores, grelhas e calhas. 

• Instalações de prevenção contra incêndios: 
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Tubulações, conexões, bombas, reservatórios, cilindros, extintores, chuveiros automáticos, 

válvulas, registros, dampers, eletrodutos, conduletes, cabos, sensores, chaves, alarmes, painéis, 

módulos, luminárias, lâmpadas, difusores e placas. 

• Instalações de óleo e gás: 

Tubulações, conexões, bombas, reservatórios, sistemas de contenção de vazamentos, filtros, 

central de medição e redução de pressão, manômetros, suportes diversos, juntas, cilindros, 

válvulas, sensores e placas. 

5.2.4 Requisitos de modelagem 

No decorrer da elaboração dos projetos, a CONTRATADA deverá atender aos procedimentos de 

modelagem definidos pela COPEL, tendo em vista a obtenção de um modelo com integridade de 

informações. 

 

6 DIRETRIZES PARA APERFEIÇOAR O INTERCÂMBIO DE ARQU IVOS 

6.1 Arquivos de desenhos 

Os desenhos entregáveis em 2D devem ser monocromáticos, com diferenciação nas espessuras 

de linhas, hachuras e preenchimentos com destaque diferenciado a cada uma das disciplinas de 

projeto, a fim de facilitar a leitura, interpretação e execução do desenho técnico. 

 

6.1.1 Microstation 

A plataforma CAD adotada pela COPEL é o Microstation V8i1. Por esta razão é o software 

preferencial para o recebimento dos arquivos de desenhos. Neste programa deverão ser 

obedecidas as seguintes configurações para a elaboração dos desenhos de projeto: 

 

• Unidades de trabalho 

Working units 
Units Names 

Master Units: m 

                                                
1 O formato padrão de arquivos do Microstation é o DGN. 
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Sub Units: cm  
Resolution 

100 cm per m 
100 Pos Units per cm 

 

• Estilos de linha 

Código  Estilo  
LC = 0 CONTÍNUA 
LC = 1 TRACEJADO PEQUENA 
LC = 2 TRACEJADO MÉDIO 
LC = 3 TRACEJADO GRANDE 
LC = 4 TRAÇO E PONTO 
LC = 5 TRACEJADO MÉDIO GROSSO 
LC = 7 TRAÇO E DOIS PONTOS 

 
 

6.1.2 AutoCAD e similares 

A apresentação dos desenhos poderá excepcionalmente ser desenvolvida em outros programas 

computacionais, podendo ser aceitos arquivos em formato padrão DWG ou outros editáveis desde 

que permitam sua leitura e edição pelo programa Microstation V8i sem a necessidade de 

alterações. A título de exemplo, a seguir são apresentadas as especificações para o programa 

Autocad versão 2010 que permitem tal leitura. 

• Unidades de trabalho 

A unidade de trabalho adotada deverá ser o metro. 

 

• Relação de traços e cores 

Código  Cores  Espessura do traço  
1 VERMELHO 0,50 mm 
2 AMARELO 0,18 mm 
3 VERDE 0,35 mm 
4 CIANO 0,25 mm 
5 AZUL 0,80 mm 
6 MAGENTA 0,65 mm 
7 BRANCO 0,13 mm 
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• Estilos de linha 

Os estilos de linha do AutoCAD que podem ser usadas são os seguintes: 

CONTINUOUS 
DOT 

DASHDOT 
DASHED 
HIDDEN 
HIDDEN2 
DIVIDE 

CENTER 
 

As espessuras das linhas deverão ser definidas à partir dos layers e a CONTRATADA deverá 

encaminhar o arquivo de extensão *.CTB de cada desenho, contendo as configurações de 

espessura adotadas. 

 

6.1.3 Textos e cotas 

Todos os desenhos elaborados nos programas computacionais Bentley devem conter a planta 2D 

em uma sheet file, ou no layout caso sejam elaborados em programas da Autodesk ou em formato 

semelhante em outros programas. Os textos, cotas e tabelas devem ser feitos na sheet file, ou 

equivalente, respeitando os padrões de cotas e textos aqui definidos. Não serão admitidas as 

variações itálico e negrito. 

 

• Textos  

A fim de estabelecer um padrão nos desenhos técnicos, entre outros documentos gerados, 

todos os textos devem ter fonte ARIAL e se enquadrar em uma das três alturas de textos 

conforme segue:  

 

ESTILO DE TEXTO ALTURA DE TEXTO EXEMPLO DE APLICAÇÃ O 

TEXTO 1 3,5 mm TÍTULOS, CABEÇALHOS  

TEXTO 2 2,0 mm NOMES DE ÁREA, INDICAÇÕES 

TEXTO 3 1,5 mm COTAS, MARCAÇÕES, SIMBOLOGIAS 
 

 

 

 



 
 

SUPERINTENDÊNCIA DE OPERAÇÔES DE GERAÇÃO E 
TRANSMISSÃO - SOS 

Revisão:  
02 

ESPECIFICAÇÃO TÉCNICA Data: 
20/11/2013 

82472-89993-9999-0001 Total de Folhas: 
17/30 

 

ELABORAÇÃO E APRESENTAÇÃO DE DOCUMENTOS TÉCNICOS E MODELOS ELETRÔNICOS DE PROJETOS - POLO BOSQUE 
COPEL 

 

• Cotas  

Todas as cotas deverão ser com fonte ARIAL e estilo de texto 3 conforme tabela de textos 

mencionada. As distâncias entre a cota e o objeto a ser cotado devem obedecer a tabela 

seguinte. O estilo de cota deve ser o DOT conforme Figura 5. 

 

COTA PRIMÁRIA  COTA SECUNDÁRIA  COTA TERCEÁRIA  

DIST. PTO. DE REF. DIST. PTO. DE REF.  DIST. PTO. DE REF. 

50 mm 80 mm 210 mm 
 

  
Figura 5  – Cotas primária, secundária e terciária.  

 

6.2 Editores de texto e planilhas eletrônicas 

Todos os textos e tabelas a constar em documentos tais como especificações técnicas, memoriais, 

listas de materiais, relatórios, instruções etc., deverão ser redigidos no idioma português (do Brasil) 

e elaborados em editores de texto e planilhas eletrônicas da Microsoft, preferencialmente, ou, 

excepcionalmente, em outros programas, desde que estes sejam perfeitamente compatíveis com o 

sistema operacional Windows e possam ser lidos e editados pelo editor de texto Word ou planilha 

Excel da Microsoft. 

6.3 Arquivos seguindo o conceito BIM 

A plataforma BIM adotada pela CONTRATADA deverá, preferencialmente, permitir o intercâmbio de 

arquivos IFC no sistema de classificação IFC 2x3 TC-1. 

Caberá à COPEL a opção pelo aceite de outros formatos de arquivo, formalmente, desde que seja 

atestada a integridade das informações inseridas no modelo elaborado pela CONTRATADA. 

No caso de estruturas metálicas, serão aceitos formatos de arquivos BIM com extensão STP ou 

STEP, oriundos do padrão CIS/2, para o modelo de análise estrutural e, para o modelo de 

Cota terciária 
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detalhamento da estrutura, serão aceitos formatos de arquivos em extensão SDF ou SDNF, 

oriundos do padrão neutro SDNF. 

 

7 APRESENTAÇÃO DOS DOCUMENTOS 
Conforme já mencionado, a COPEL utiliza o sistema de gerenciamento eletrônico de documentos 

da Bentley, o ProjectWise. Este programa permite a organização, controle de acesso e de 

visualização dos arquivos, controle do fluxo de submissão e liberação (incluindo o registro de 

datas) e o controle de revisões, dentre outras funcionalidades disponíveis para os documentos 

gerenciados neste sistema. 

A COPEL utilizará o ProjectWise para disponibilizar quaisquer arquivos eletrônicos à 

CONTRATADA, assim como esta deverá emitir todos os arquivos eletrônicos dos documentos 

técnicos, inclusive dos modelos de informação da construção, através desse sistema. Para que isto 

seja possível, a COPEL disponibilizará à CONTRATADA, por intermédio do profissional 

responsável pelos serviços de Coordenação e Compatibilização dos projetos, um usuário e senha2 

para acesso ao sistema ProjectWise pela Internet. 

As submissões de documentos para a Liberação da COPEL deverão ser feitas nas pastas 

existentes nomeadas de “Entrada”. A submissão de cada documento deverá ser feita dentro da 

pasta do respectivo Programa (neste caso EA005), Grupo, Obra, Disciplina de projeto/certificação e 

Estágio de projeto/certificação ao qual o documento pertence. Sendo assim, a CONTRATADA 

deverá postar os documentos em uma pasta de sub nível 6, conforme ilustra a Figura 6. A COPEL 

disponibilizará arquivos eletrônicos dos documentos que sejam de sua responsabilidade em outra 

pasta de sub-nível 6, denominada “Saída”. 

 

                                                
2 O usuário e senha fornecidos pela COPEL são de uso pessoal e intransferível do profissional responsável 
pelos serviços de projetos, indicado na Proposta Técnica da CONTRATADA. 
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Figura 6 – Pastas de entrada e saída de documentos de projeto. 

 

Na pasta da disciplina de projeto existirão até 6 (seis) pastas, sendo que até 5 (cinco) destas 

corresponderão aos estágios de desenvolvimento do projeto (Estudo Preliminar, Anteprojeto, 

Projeto Legal, Projeto Básico e Projeto Executivo) e 1 (uma) corresponderá ao Modelo de 

Informação da Construção (BIM). A pasta referente ao estágio de desenvolvimento do projeto 

denominada Projeto Legal, fará parte das disciplinas cuja aprovação do projeto na prefeitura, em 

órgãos públicos ou concessionárias de serviços é necessária para execução da obra ou do serviço. 

Na pasta da certificação existirão até 4 (quatro) pastas correspondendo aos diferentes tipos de 

documentos produzidos pela consultoria. 

Dentro destas pastas existirá uma subpasta com o nome “Entrada” e outra com o nome “Saída”. 

Nas pastas “Entrada” dos estágios de projeto deverão ser emitidos os documentos que consistem 

de representações gráficas no plano, textos e planilhas, destinados à materialização em papel para 

arquivamento, documentação, execução ou operação da obra ou serviços. Na pasta “Entrada” do 

modelo deverá ser disponibilizado o modelo de informação da construção da referida disciplina de 

projeto, e todos os demais arquivos que o compõe. 

Os documentos deverão ser disponibilizados para análise na subpasta “Entrada” com nomes de 

acordo com as regras descritas no item 7.2. Para o preenchimento do nome do arquivo, o sistema 

ProjectWise disponibilizará opções relacionadas às pastas em que o documento está sendo 

disponibilizado. Após a gravação dos documentos nesta pasta, eles deverão ter seu status alterado 

de “Documento Criado” para “Para Liberação”. 
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Após a mudança de status, os mesmos não poderão ser renomeados, editados ou excluídos pela 

CONTRATADA, pois a COPEL entende e estabelece que para ser submetido à liberação, o 

documento encontra-se na versão final correspondente ao estágio de detalhamento do projeto, ou 

seja, que ele atende os requisitos definidos nas especificações de elaboração dos projetos, nesta 

especificação e no termo de referência, e está devidamente revisado e compatibilizado pela 

CONTRATADA. 

Os documentos deverão ser disponibilizados em formatos editáveis e em formatos não-editáveis, 

no mínimo a cada marco contratual. No caso de documentos de desenho ou modelos oriundos de 

programas da família AutoDesk3 ou Bentley, o formato não editável aceito será o i-model e, no caso 

de documentos oriundos de planilhas eletrônicas, editores de texto e apresentações, o formato não 

editável aceito será o PDF. 

Caberá à COPEL a opção pelo aceite de outros formatos de arquivos não editáveis caso a 

plataforma BIM da CONTRATADA não seja capaz de gerar arquivos em formato i-model. 

Em qualquer etapa de apresentação dos modelos de informação da construção (BIM) à COPEL, a 

CONTRATADA deverá elaborar uma lista contendo todos os objetos modelados e indicação dos 

tipos de informações não gráficas atribuídas a cada um destes objetos. 

Todos os documentos técnicos e modelos eletrônicos desenvolvidos pela CONTRATADA serão e 

permanecerão como propriedade exclusiva da COPEL, que deles poderá fazer o uso que bem lhe 

aprouver, resguardados os direitos autorais de seus criadores e a legislação pertinente. 

Os documentos técnicos e modelos que forem apresentados de forma incompatível com esta 

Especificação Técnica, em arquivos inválidos ou corrompidos, sem conteúdo ou cujo conteúdo não 

corresponda ao nome dado ao arquivo, não serão considerados entregues devendo ser 

prontamente corrigidos pela CONTRATADA, sem ônus para a COPEL e sem aditamento de prazos. 

7.1 Análise dos documentos submetidos 

A COPEL fará sua análise a partir dos documentos em formatos não editáveis, criados a partir dos 

documentos editáveis em formato nativo, ambos recebidos da CONTRATADA. Sendo assim, os 

documentos editáveis recebidos deverão ter informações e representações gráficas compatíveis 

com os documentos não editáveis recebidos. 
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Depois de analisados pela COPEL, os documentos disponibilizados “Para Liberação” poderão 

adquirir o status de “Liberado”, caso não apresentem nenhuma inconformidade, ou “Não Liberado”, 

caso os documentos apresentem inconformidades para serem sanadas. 

Os documentos gerados pelos analistas da COPEL, tais como relatório de análise e evidências de 

verificação, serão disponibilizados para a CONTRATADA na pasta “Saída”, ilustrada na Figura 6. 

O fluxo de trabalho adotado para a análise dos documentos pela COPEL bem como as regras de 

versionamento dos documentos são descritos no item 7.3. 

7.2 Regras de nomenclatura dos documentos 

Todos os documentos disponibilizados no ProjectWise4 pela CONTRATADA deverão possuir 

codificação baseada em critérios de rastreabilidade estabelecidos pela COPEL. Este código varia 

de acordo com o local do projeto, o tipo, número e estágio da obra, o tipo de documento técnico, a 

disciplina e subdisciplina de projeto e com o nível de detalhamento do projeto, conforme o Quadro 

2. 

Quadro 2 – Numeração dos documentos 

Formato de numeração dos documentos:  

“AAAAA-8BBCC-DEEF-GGGG” 

Código  Significância  Listagem  Exemplos  

AAAAA 
Refere-se ao Código de 

Área (CAR) da obra. - 

- 00000 (Típico) 

- 82472 (Polo Bosque 

Copel). 

- 82492 (Polo KM3). 

8BBCC 

“BB”  refere-se à 

disciplina de projeto ou 

certificação 

00 – Modelo geral 
01 – Arquitetura 
02 – Paisagismo 
03 – Conforto Acústico 
11 – Terraplenagem e Drenagem 
12 – Pavimentação e Sinalização 
13 – Estruturas e Fundações 
14 – Sistemas Hidráulicos e Sanitários 
15 – Prevenção de Incêndio 
21 – Climatização 
22 – Instalações de Óleo e Gás 
23 – Sistemas de Transporte 
31 – Sistemas Elétricos 
32 – Cabeamento Estruturado e Telefonia 

 

                                                                                                                                                              
3 O i-model poderá ser criado nos softwares AutoDesk mediante a utilização de um add-in disponibilizado 
gratuitamente pela Bentley em: http://www.bentley.com/en-US/Free+Software/imodel+plugin+revit.htm. 
4 Exceto os arquivos e documentos alocados nas pastas denominadas “apoio” e “documentos 
comprobatórios”. 
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33 – Automação e Segurança 
41 – Certificação em Sustentabilidade Ambiental 
42 – Certificação em Conservação de Energia 
43 – Certificação em Data Center 
99 – Geral 

“CC”  refere-se à (aos) 

subdisciplina 

(componentes) de (o) 

projeto 

Todas as disciplinas de projeto, exceto as 

relativas às certificações, possuirão as 

seguintes subdisciplinas típicas : 

00 - Modelo 
90 - Estudos / relatórios 
91 – Memoriais de cálculo / Memoriais 
descritivos 
92 - Listas 
93 - Especificações / Normas 
94 - Manuais 
95 - Planejamento 
 

As subdisciplinas específicas  de cada 

disciplina de projeto encontram-se descritas no 

Quadro 3.  

DEEF 

“D”  refere-se ao tipo de 

obra 

0 – Obra externa 
1 – Bloco 
2 – Central de Água Gelada, Central de 
Climatização e Geração ou Central de Geração 
3 – Subestação 
4 – Portarias e guaritas 
... 
8 – Outras edificações 
9 – Típico 

- 0001 (Obras externas, 

1º estágio da obra); 

- 1011 (Bloco 1, 1º 

estágio da obra); 

- 1012 (Bloco 1, 2º 

estágio da obra); 

- 1020 (Bloco 2, estágio 

único de obra). 

“EE”  indica o número da 

obra 

00 – Obra única 
01 – Obra 1 
02 – Obra 2 
... 
99 – Não aplicável 

“F”  indica o estágio da 

obra 

0 – Estágio único de obra 
1 – Estágio 1 da obra 
2 – Estágio 2 da obra 
... 
9 – Não aplicável 

GGGG Número de ordem. Número natural sequencial de quatro dígitos, 

iniciando em 0001.. 
0001, 0002, 0003, ... 

 

Para otimizar a numeração dos documentos, os códigos “AAAAA”, “8BB”, “D” e “EE” serão 

preenchidos automaticamente desde que sejam postados nas pastas corretas. Os demais códigos, 

tal como o “CC” listado no Quadro 3, deverão ser preenchidos pela CONTRATADA a partir de uma 

lista de opções disponível durante o preenchimento dos campos. 
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Quadro 3 – Subdisciplinas (Componentes) de(o) proje to ou da certificação 
Disciplinas de projeto  Subdisciplinas (Componentes) de(o) projeto  
Arquitetura 01 - Edificações 

02 - Equipamentos incorporados 
03 - Esquadrias 
04 - Forros 
05 - Pisos 
06 - Impermeabilização 
07 - Mobiliário 
08 - Comunicação visual 

Paisagismo 01 - Paisagismo 
Conforto Acústico 01 - Conforto acústico 
Terraplenagem e Drenagem 01 - Serviços preliminares 

02 - Terraplenagem 
03 - Obras de terra 
04 - Drenagem 

Pavimentação e Sinalização 01 - Pavimentação 
02 - Sinalização 

Estruturas e Fundações 01 - Fundações 
02 - Estrutura de concreto moldado no local 
03 - Estrutura de concreto pré-moldado 
04 - Estrutura de aço e mista 
05 - Estrutura de madeira 
06 - Alvenaria estrutural 

Hidráulico e Sanitário 01 - Sistema de água fria e quente 
02 - Sistema de águas pluviais 
03 - Sistema sanitário 
04 - Sistema de reuso de águas 
05 - Infraestrutura e equipamentos 

Prevenção de Incêndio 01 - Sistema de detecção e alarme de incêndio 
02 - Sistema de combate a incêndio 
03 - Sinalização e iluminação de emergência 
04 - Infraestrutura e equipamentos 

Climatização 01 - Diagramas mecânicos 
02 - Equipamentos e tubulações 
03 - Distribuição de ar, ventilação e exaustão 
04 - Refrigeração 

Instalações de Óleo e Gás 01 - Diagramas mecânicos 
02 - Equipamentos e tubulações 

Sistemas de Transporte 01 - Diagramas mecânicos 
02 - Elevadores e plataformas elevatórias 
03 - Talhas e pontes rolantes 

Sistemas Elétricos 01 - Entrada e medição de energia 
02 - Instalações em alta tensão 
03 - Instalações em média tensão 
04 - Instalações em baixa tensão 
05 - Luminotécnica 
06 - Distribuição de energia garantida 
07 - SPDA e aterramento 
08 - Diagramas elétricos 
09 - Montagens eletromecânicas 

Cabeamento Estruturado e 
Telefonia 

01 - Cabeamento estruturado 
02 - Dados e lógica 
03 - Som, áudio e vídeo 
04 - Telefonia 
05 - Diagramas de blocos e Bayface 
06 - Montagens eletromecânicas 
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Automação e Segurança 01 - CFTV 
02 - Controle de acesso 
03 - Alarmes e sensoriamento 
04 - Automação predial 
05 - Sistema DCIM – DataCenter 
06 - Diagramas de automação 
07 - Montagens eletromecânicas 

Certificação em Sustentabilidade 
Ambiental 

00 - Estudos 
01 - Relatórios 
02 - Dossiê para Certificação 
03 - Plano de modelagem 
04 - Simulação termoenergética - Edifício real  
05 - Simulação termoenergética - Edifício de referência 
06 - Simulação de iluminação natural 
07 - Simulação de iluminação artificial ou integrada  
 
92 - Listas ou tabelas 
93 - Especificações e normas técnicas 
94 - Manuais ou cartilhas 
95 - Relatórios e documentos da certificadora 
96 - Certificados 
 

Certificação em Conservação de  
Energia 

00 - Estudos 
01 - Relatórios 
02 - Dossiê para Certificação 
03 - Plano de modelagem 
04 - Simulação termoenergética - Edifício real  
05 - Simulação termoenergética - Edifício de referência 
06 - Simulação de iluminação natural 
07 - Simulação de iluminação artificial ou integrada  
 
92 - Listas ou tabelas 
93 - Especificações e normas técnicas 
94 - Manuais ou cartilhas 
95 - Relatórios e documentos da certificadora 
96 - Certificados 
 

Certificação em Data Center 00 - Estudos 
01 - Relatório 
02 - Dossiê para Certificação 
 
92 - Listas ou tabelas 
93 - Especificações e normas técnicas 
94 - Manuais ou cartilhas 
95 - Relatórios e documentos da certificadora 
96 - Certificados 

 
Além dos campos acima, existem uma série de outros atributos que não fazem parte da 

nomenclatura do documento, mas que devem ser preenchidos para facilitar a rastreabilidade. Por 

exemplo, deve-se atribuir a cada documento o seu tipo conforme as opções relacionadas no 

Quadro 4. 
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Quadro 4 – Tipos de documentos técnicos 
 

Disciplinas de projeto  

(00, 01, 02, 03, 11, 12, 13, 14, 15, 21, 22, 23, 31, 32, 33, 99) 

Disciplinas de certificação  

(41, 42, 43) 

• Modelo 
• Desenho 
• Estudo de Viabilidade Técnica e RAP 
• Relatório Técnico 
• Memória de Cálculo 
• Memorial Descritivo 
• Lista 
• Especificação Técnica 
• Norma Técnica 
• Manual 
• Cronograma 

• Estudo 
• Relatório Técnico 
• Dossiê 
• Plano 
• Modelo 
• Lista 
• Especificação 

Técnica 
• Manual 
• Certificado 

 

Documentos com campos obrigatórios não preenchidos ou preenchidos em desacordo com o 

estabelecido nesta especificação ou em seu anexo serão excluídos do Project Wise, devendo ser 

prontamente corrigidos pela CONTRATADA, sem ônus para a COPEL e sem aditamento de prazos. 

 

7.3 Regras de versionamento de documentos 

Cabe ao profissional ou empresa responsável pela elaboração, versionar o documento que será 

submetido à Fase de Liberação, bem como versionar documento Não Liberado na Fase de 

Liberação. O fluxograma de liberação de um documento está ilustrado na Figura 7. 

 

 
Figura 7 – Fluxograma simplificado de documento ela borado por empresa CONTRATADA  

 

7.3.1 Documento na Fase de Elaboração 

Cabe ao profissional ou à empresa responsável pela elaboração do documento, elaborá-lo e, 

necessariamente, revisá-lo  antes da submissão à Fase de Liberação, que é de responsabilidade 

da COPEL. 

Como boa prática no processo de elaboração, recomenda-se que o elaborador adote regras de 

versionamento de documentos exclusivamente para seu controle pessoal. 
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O código de versionamento de documentos a serem submetidos à Fase de Liberação será 

numérico, iniciando pelo número 0 que corresponderá à emissão inicial para liberação. 

7.3.2 Documento submetido à Fase de Liberação 

Quando um documento for submetido à Fase de Liberação  e, após a análise da COPEL, for 

considerado Liberado , o código de versionamento permanecerá sendo numérico sem mudança de 

valor. Caso o documento não seja Liberado , deverá retornar para a Fase de Elaboração  e seu 

código de versionamento deverá mudar para o primeiro número inteiro subsequente e maior que o 

código da versão não liberada. 

 

8 ORIENTAÇÕES PARA POSTAGEM DE DOCUMENTOS NO PROJEC TWISE 
 

8.1 Postagem inicial de documentos 

A primeira postagem de qualquer documento no ProjectWise deverá ser em formato editável, com 

número de revisão igual a 0, realizada conforme o procedimento descrito à seguir5: 

• Documento em formato editável: 

1) Dentro do ProjectWise Explorer, acesse o menu “Document” -> “New” -> “Document...”. Na 

janela de criação de documentos, selecione a opção “Advanced Wizard”. Na janela 

“Advanced Document Creation Wizard”, clique em “Avançar>”. 

2) A janela que será exibida apresentará a estrutura de pastas do Datasource ativo. Escolha a 

pasta “Entrada” do respectivo projeto ou certificação e clique em “Avançar>”. 

3) Na janela atual, será solicitado o arquivo que servirá de modelo para a criação do novo 

documento. Selecione a segunda opção, “Use external file as a template” e clique no botão 

“Browse...” para escolher o arquivo do documento que está sendo postado. Depois de 

escolhido o arquivo, clique em “Avançar>”. 

4) Na janela atual será definido o código do documento. Preencha todos os campos editáveis 

na sequência. No campo “Sequencial”, utilize o botão “Generate” para obter 

automaticamente o próximo número de ordem disponível e clique em “Avançar>”. 

                                                
5 A análise da Copel somente será iniciada se também forem cumpridos os requisitos dos itens 8.3 e 8.7. 
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5) Será exibida uma janela para a definição dos atributos do documento. Preencha todos os 

campos com as informações corretas e clique em “Avançar>” até que seja concluída a 

criação do novo documento. 

 

• Documento em formato não-editável: 

1) Dentro do ProjectWise Explorer, acesse o menu “Document” -> “New” -> “Document...”. Na 

janela de criação de documentos, selecione a opção “No Wizard”. 

2) Na janela “Create Document”, na aba “General”, preencha o campo “Name:” com o número 

do respectivo documento, gerado pelo ProjectWise quando foi submetido o arquivo em 

formato editável. O número do documento está localizado no campo à direita do 

ProjectWise, conforme mostra a Figura 8. 

 

Figura 8 – Campo com identificação do número do doc umento no ProjectWise. 

 

3) Na mesma aba, preencha o campo “Version:” com o mesmo número de revisão em que o 

respectivo documento editável se encontra. Ainda na mesma aba, na caixa “File”, clique no 

botão “Advanced” e selecione a opção “Import”. Escolha o arquivo não-editável do 

respectivo documento e selecione “Abrir”. 

4) Clique em “Save” para finalizar a criação do documento. 

 



 
 

SUPERINTENDÊNCIA DE OPERAÇÔES DE GERAÇÃO E 
TRANSMISSÃO - SOS 

Revisão:  
02 

ESPECIFICAÇÃO TÉCNICA Data: 
20/11/2013 

82472-89993-9999-0001 Total de Folhas: 
28/30 

 

ELABORAÇÃO E APRESENTAÇÃO DE DOCUMENTOS TÉCNICOS E MODELOS ELETRÔNICOS DE PROJETOS - POLO BOSQUE 
COPEL 

 

8.2 Criação de revisões 

Após a análise da COPEL6, caso existam inconformidades no documento, a Contratada deverá 

efetuar as correções necessárias e postar o documento de projeto (tanto em versão editável como 

não-editável) novamente no ProjectWise, porém com a versão identificada pelo número 

subsequente, conforme procedimento descrito à seguir: 

1) Dentro do ProjectWise Explorer, localize o documento que terá uma nova versão, clique 

com o botão direito do mouse sobre ele e no menu que aparecerá escolha a opção “New” -> 

“Version...”. Deverá aparecer a janela “New Document Version”. Na aba “Version” preencha 

na última caixa de texto “Version” o número subsequente da revisão. Na aba “Comments”, 

na caixa de texto “Enter Comments:”, preencha com os comentários e clique em “OK”. 

2) Depois de realizada a tarefa acima, um documento com um número de revisão superior 

será criado, porém com o mesmo número de identificação, mesmos atributos e mesmo 

conteúdo do documento original. 

3) Para modificar o conteúdo do documento da nova versão criada, clique com o botão direito 

do mouse sobre o documento e, no menu que será aberto, selecione a opção “Modify”. 

4) Na janela “Modify document” que aparecerá, na aba General, clique sobre o botão com uma 

seta, no canto inferior direito da janela, e selecione a opção “Replace File Content”. 

5) Será exibida a janela de seleção de arquivos intitulada “Select file with one to replace the 

document file content”. Selecione o arquivo e clique em “Abrir”. Clique em “OK” na janela 

“Modify document” para confirmar a modificação do conteúdo. 

8.3 Postagem de projetos para liberação 

1) Acesse a pasta de nome “Entrada” do referido projeto. 

2) Crie ou revise os documentos que compõem o referido projeto dentro da pasta “Entrada”, 

conforme o item 8.1 ou o item 8.2. 

                                                
6 A CONTRATADA não deverá efetuar uma nova revisão de um determinado documento no ProjectWise até 

que a COPEL emita seu parecer em relação a última revisão postada desse mesmo documento. Caso isto 

não seja observado pela CONTRATADA, a COPEL excluirá a nova revisão do documento do sistema e 

informará a CONTRATADA.  
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3) Após finalizar a criação/revisão dos documentos, clique em cada um deles com o botão 

direito do mouse e escolha a opção “Change State” -> ”Next”. Os documentos passarão do 

estado “Documento Criado” para “Para Liberação”. 

4) Somente após a mudança do estado dos documentos, a COPEL receberá um aviso de que 

existem documentos para serem analisados e o prazo contratual de análise passará a ser 

contado. Além deste aviso, deverá ser encaminhado um e-mail para a COPEL informando 

que o projeto está disponível para análise. O projeto só será considerado entregue se for 

postada a lista de documentos de projeto e todos os documentos listados com o status 

“Para Liberação”. 

8.4 Leitura e cópia de documentos disponibilizados pela COPEL 

1) Acesse a pasta de nome “Saída” do referido projeto. 

2) Selecione o documento de projeto, clique com o botão direito do mouse e escolha a opção 

“View” ou “Open as Read-Only”, para fazer a leitura do documento, ou escolha a opção 

“Copy Out”, para que o documento seja copiado para o disco rígido do computador do 

usuário. 

8.5 Recebimento de mensagens 

1) Dentro do ProjectWise Explorer, acesse o menu “Tools” -> “Messenger...” para abrir o 

ProjectWise Messenger. 

2) Dentro do ProjectWise Messenger, na caixa “Folder List” do lado esquerdo, selecione a 

pasta “Inbox” para ver as mensagens recebidas. 

8.6 Envio de mensagens 

1) Dentro da janela “ProjectWise Messenger” acesse o menu “Message” - > “New...” para criar 

uma nova mensagem. 

2) Dentro da janela de criação da mensagem, clicar no botão “To...”. Aparecerá a janela de 

seleção dos destinatários. 
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3) Selecione na caixa do lado esquerdo os usuários destinatários da mensagem7 e clique no 

botão “To ->” para passar para a caixa do lado direito. Fazer o mesmo procedimento, 

utilizando o botão “Cc ->” para selecionar os usuários que serão copiados na mensagem. 

Clique em “OK” ao final. 

4) Dentro da janela “Untitled”, preencha o campo “Subject” com o assunto da mensagem e 

escreva no campo abaixo o conteúdo da mensagem. 

5) Na mesma janela, acessar o menu “File” -> “Insert Document” para inserir um anexo contido 

no ProjectWise, caso haja a necessidade. 

6) Para enviar a mensagem, acesse o menu “File” -> “Send”. 

8.7 Observações 

1) Em caso de dúvidas na postagem ou revisão de documentos no ProjectWise, consultar a 

COPEL antes da conclusão do procedimento. 

2) As empresas CONTRATADAS devem observar os conteúdos mínimos exigidos em cada 

documento nas especificações de prestação de serviços de cada contrato. 

3) Partes de um único documento, postadas como diferentes documentos no ProjectWise 

serão excluídas do sistema. Neste caso, a COPEL comunicará o usuário que postou o 

arquivo para que efetue a devida correção e postagem correta como um único documento. 

4) Documentos ou arquivos compactados (em qualquer extensão) ou documentos executáveis 

(tais como nas extensões exe, bat, html e js) ou documentos com macros serão excluídos 

do sistema. Neste caso, a COPEL comunicará o usuário que postou o arquivo para que 

efetue a devida correção e postagem correta do(s) documento(s). 

5) Documentos que contenham anexos devem ser apresentados juntamente com o documento 

principal (no mesmo arquivo). 

6) As pastas de Apoio das disciplinas do Quadro 2 devem ser utilizadas para troca de arquivos 

não oficiais, ou seja, que não caracterizem as entregas da COPEL e das empresas 

CONTRATADAS previstas nos contratos. 

                                                
7 Para identificar quem são os usuários, selecione o nome do usuário e clique no botão “Properties”.  


